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Preliminary Testing Phase:

The initial testing will be focused on the Cloud hosted database environment as this is the area that current sites
will be focused on migrating to. Further information will be posted at a later point detailing the setup in a Local
environment.

Development-X has setup an Amazon Server (located in Sydney) and loaded a Demo company "Sydney AWS" in an
Update 243 environment.

Each Partner will receive their own User Name and default Password of "pass". Upon logging into this company
you will be required to change that password to a stronger unique password. (The mandatory changing of the
initial password is a new feature within Update 243).

The primary purpose of this preliminary testing is to ensure the environment is robust and stable and performs
well when multiple users are logged on and using Ostendo. As Partners have a wide range of knowledge in specific
areas of Ostendo, we encourage you to run typical processes your own client sites use frequently.

Initial Testing In Dev-X Cloud Environment:

The primary purpose of this preliminary testing is to ensure the environment is robust and stable and performs
well when multiple users are logged on and using Ostendo. As Partners have a wide range of knowledge in specific
areas of Ostendo, we encourage you to run typical processes your own client sites use frequently.

The following areas should be fully tested by as many Partners as possible:

® Speed and performance of loading of screens (eg: Sales, Jobs, Purchase and Assembly)
® Speed of Navigation around the product including running workflows and menu structures.

® Batch Processes: There have been many processes we have now moved from the application and replaced
with Store Procedures that run at a Server level rather than at the Client level. This approach has a number of
advantages. eg:

O The processing power of the Server is utilised thereby removed processing at each client machine.
This results in these routines now running faster than previously.

O Ifthereis a problem (eg: error) when the Stored Procedure is run, Firebird will roll back the entire
transaction and not leave some records posted whilst others are not. This leads to a more robust
environment.

O There will be opportunities in future whereby scripting will be able to post some transactions
previously left to the client machine. eg: Posting of Timesheet Batches and Batch Invoicing

Processes that have been moved to Store Procedures include:

O Time Sheet Posting
O  Batch Invoicing

Inventory Replenishment performance

Assignment Board performance

Operations Centre performance. (No emailing capability as yet)
Running Reports

POS

New Functionality



Overview

Update 243 can be configured to use 'either' HTTPS or TCP/IP protocols.

HTTPS
® |s always used where the database is hosted on a remote cloud server

® (Can be used on a Local Server if remote access is required by users however requires additional server
software.

TCP/IP

® |srecommended for use on a Local Server where no remote access is required by users (eg: Local Area
Network only)

HTTPS Deployment:

® The Systems Administrator will generate a configuration file for each database using a special Server Utility.
This file will be sent to each user requiring access

® The Configuration file(s) is then simply imported from a Client Configuration utility into a Remote settings
screen

TCP/IP Deployment:

®  From the Client Configuration utility, each user manually adds a configuration record using the Client
Configuration utility into a Local settings screen

The Client Configuration Utility is only used to record details of Update 243 databases. Update 242 databases are
accessed as they are at present

Initial Client Setup

Client Setup:

To allow preliminary testing of Update 243 against a demo database we have on an Amazon server, you will
receive a zip file from Development-X containing the following files:

1. SydneyAWSconfig.cgf
2. ostendoconfig.exe

®  Unzip the zip file to a temp location

® Move the "ostendoconfig.exe" file to your local Ostendo folder (in My Documents on your own PC) DO NOT
PUT THIS FILE IN THE OSTENDO FOLDER ON YOUR SERVER

®  Run the "ostendoconfig.exe" (IMPORTANT: Run As Administrator)
®  Click on the Companies (Remote) Tab and then press the "Load" button
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& Ostendo Client Configuration

Companies (Local Ostendo Updates  Utlity Updates  Import Existing Settings
Default Company: [ select Company on Startup

Company Name Company Colour

= o X

Set Default Company

Host Name:Port

Database Id

Connectionkey1

Action

Close

-

[ Add

Save
¥ Cancel
x Delete

Load

® Browse to the "SydneyAWSconfig.cfg" file in the temporary location and press the 'Open' button
® A confirmation message with then be displayed:
Infarmation >
o Company configurations were lcaded
3
[ ]

Now set the Default Company by pressing the "Set Default Company Button"

© Ostendo Client Configuration

— a X
Companies (Local) Companies (Remote) Ostendo Updates  Utility Updates  Import Existing Settings
Default Company: Sydney AWS [Remote] D Select Company on Startlp Close
Company Name Company Colour Host Mame:Port Database 1d ConnectionKey 1 Action M
| Sydney AWS ||:| Color not selected |htu:|s:ﬂosbendodoud.oom:2001 ADB430D4744744ESB 18247 109571C358 |06E560EC9FA24BSCA].271F D Add
H Save

) Cancel
x Delete

® Go to the "Ostendo Updates" tab and dropdown the "Action" button and select "Download & Install". This will

download the latest version of the ostendo.exe (Update 243) file to your Ostendo folder on your PC.

&) Ostendo Client Configuration

= ] X
Companies (Local) Companies {Ramobel Ostendo Updates :lhhty Updates Import Existing Settings

Description Application Installed Version Available Version Required DB Edition Close
»|Ostendo Application |ostenda 2025.1.1.105 243
Download 8¢ Install
— I——
®  Your My Documents Ostendo folder on your PC should now contain the following files:
O ostconfig.cfg
O ostendo.exe
O ostendoconfig.exe
[ ]

From this folder create a Desktop Shortcut of the Ostendo.exe and name that Shortcut "Ostendo 243" (The
Public Release will allow a shortcut icon to be created)
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®  You are now ready to log onto the Ostendo "Sydney AWS" test Company and start testing Update 243

Please ignore the other Tabs and Actions in the Ostendo Client Configuration screen as work on these is on-going.

Functionality

This section contains specific details of functionality changes within Update 243

Auto Updating of Ostendo Executable Builds

Ostendo monitors Executable Build changes automatically. Previous these were manually deployed and became
difficult to maintain. In Update 243 the ostendo.exe file is located in the same folder as the Ostendo Client
Configuration utility on each PC. Ostendo now monitors for Build changes automatically and alerts the user if a
new build is available when that user logs onto Ostendo. The Ostendo.exe file is loaded on each PC in the My
Documents folder for that machine.

Process:

® The Ostendo user launches Ostendo and logs on as usual. If a new Ostendo.exe build is available,
an"Ostendo Updates" screen is automatically launched, allowing the user to either "Get the Update" and
Install that build or exit out of this screen and continue with the current build loaded on their PC. (Our
recommendation would be to always Get the Update)

1. Pressthe Get Update button
2. A notes area in this screen details changes relating to this new build

stendo Application

Get Update

Fix for Order touch panel showing e

® After pressing the Get Update button, Ostendo will Close and the Ostendo Client Configuration Utility will be
opened showing

1. The Installed Version Number (Highlighted in Red if the Ostendo.exe Version is earlier than the
Available Version)

2. The Available Version Number
3. Press the "Action" button and select "Download & Update"



& Ostendo Client Configuration o 9 = [m] X
Ostendo Updates  Utiity Updates
Desciption Application Installed Version Available Version Required DB Edition Close

» Ostendo Application ostendo 2025.1,1,104 2025,1.1.105 243 3

Download & Update

Downloading ostendo.exe

Pleaze Wait...

Please OK to proceed

|
0 You will need to restart Ostendo

Behind the scenes, the original Ostendo.exe build was renamed in this example from ostendo.exe to
ostendo_202511104.exe and the new (current) build named ostendo.exe

The Ostendo Client Configuration screen now shows the Ostendo.exe build on the PC is the same as the
current build available

Ostendo Updates  Utility Updates
Description Application Installed Version Available Version Required DB Edition
»|Ostendo Application ostendo 2025,1,1,105 2025,1,1,105 243

Close the Ostendo Client Configuration screen

Now re-launch Ostendo

Updating of the Client Configuration Utility

From time to time Development-X will publish updated versions of the Ostendo Client Configuration Utility. These

can be updated by the following process on each Client PC.

Process:

Launch the Ostendo Client Configuration Utility (ostendoconfig.exe) from your My Documents\Ostendo folder

As Administrator

1. Select the "Utility Updates" tab

2. The Installed Version Number (Highlighted in Red if the ostendoconfig.exe version is earlier than the

Available Version)
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3. The Available Version Number
4. Pressthe "Action" button and select "Download & Update"

&) Ostendo Client Configuration = m] K
Companies (Local) Companies (Remote) Ostendo Updates  Utlity Updates  Import Existing Settings
Description Application Installed Version Available Version Close
» | Ostendo Client Configuration ostendoconfig 2025.1.1.4 2025.1.1.5
o ®
Download & Update

Downloading ostendoconfig.exe

Pleaze Wait...

Please OK to proceed

Information *

o Ostendo Configuration has been updated and will now
close, please restart

® Behind the scenes, the original ostendoconfig.exe build was renamed in this example from ostendoconfig.exe
to ostendo_2025114.exe and the new (current) build named ostendoconfig.exe

® |f you were to re-launch the Ostendo Client Configuration Utility and select the Utility Updates tab, it will now
show the Installed version is the same as the current available version

G O ie 3
Companies {Local) Companies (Remote) Ostendo Updates IUt‘Iitg.r Updates I Import Existing Settings

Description Application Installed Version Available Version
¥ Ostendo Client Configuration ostendoconfig 2025.1.1.5 2025.1.1.5

® (Close the Ostendo Client Configuration screen

User Defined Defaults

File-> Customisation Configuration -> User Defined Defaults

The idea of this feature is to allow you to defined default field values. This can be useful when setting up new
records be they Orders, Customers, Supplier, Iltems etc.. These User Defined Defaults can occur when a new record
is 'Inserted' into the database or when an existing record is Updated.

This frees up the user to simply focus on specific fields when entering a new record or order etc.. thereby leaving
Ostendo to manage the default field values defined for the organisation.

This feature avoids the need for defining Required Fields, Custom Triggers and Screen Data Scripts in order to
force a field value.

There are four methods that control when a Default Field Value can be used:

8137
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Note:
O
O
O
O
Hint:

On Insert when Blank

On Insert and Update when Blank
On Insert Always

On Insert and Update Always

When setting a default field value that requires validation, ensure the field value you define is
correct in every way eg: Case Sensitivity, spelling etc..

When defining a 'From Clause' and 'Conditional Clause' that relate to more than one table, you must
prefix each field name with the Table Name

eg: JobHeader.SalesPerson (aliases may be used to abbreviate table names 'OTHER' than Primary
Table Name)

These rules are run whenever a record is either inserted or updated in the database. This includes
records being entered or amended via external sources eg: Data Imports or API

Ostendo runs User Defined Defaults,Validations and Action in the following sequence
1. User Defined Defaults
2. User Defined Validations
3. User Defined Actions

When defining a User Defined Default with 'From and Conditional' Clauses it is suggested you first test your
syntax in the Data Spreadsheet (General -> Data Spreadsheet) feature of Ostendo prior to implementing the
default values rule.

eg:

Select Jobheader.SalesPerson from JOBHEADER,CUSTOMERMASTER where JOBHEADER.CUSTOMER =
CUSTOMERMASTER.CUSTOMER and CUSTOMERMASTER.CUSTOMERTYPE = 'Services' and
JOBHEADER.JOBCATEGORY = 'Plumbing'

Fields:

o

o

O

Table Name: Drop Down and select the Table Name of the Field you wish to define the Default Value
against

Field Name: Drop Down and select the Field Name of the Field you wish to define the Default Value
against
Default When:

®=  On Insert When Blank: This rule will run only when the Field Name (defined above) is left
Blank on the screen when adding a new record

*  OnlInsert and Update When Blank: This rule will run only when the Field Name (defined
above) is left Blank on the screen when either adding or updating a record

*  On Insert Always: This rule will always run when the Field Name (defined above) is either
blank or has an entry in it only when adding a new record

*  OnlInsert and Update Always: This rule will always run when the Field Name (defined above)
is either blank or has an entry in it when either adding or updating a record

Default Field Value: This maybe a Literal value (ie: Free-form text or a Field Value).

®= NB:When this is a Literal Value, care must be taken if this Value is a validated entry. eg:
Jane Steel, not jane Steel

= |If a Field Value is to be used, simply enclose the field with square brackets eg:
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[CUSTOMERMASTER.SALESPERSON]
= A Domain Value does not need to be enclosed in single quotes.

O  From Clause: Specify the Table Name(s) to be used in the Conditional Clause eg:
JOBHEADER,CUSTOMERMASTER

O Conditional Clause: Specify the conditioning syntax from the 'where' clause in the SQL. eg:
JOBHEADER.CUSTOMER = CUSTOMERMASTER.CUSTOMER and CUSTOMERMASTER.CUSTOMERTYPE =
'Services' and JOBHEADER.JOBCATEGORY = 'Plumbing'

O  Rule Status: These options allow you to control the Status of this rule.

=  Restricted to User: (Default) Select this only to allow a specific user to test this Default
before it is released to all Users. (This is used in conjunction with the Test User Option)

= Active For All Users: This Rule is now available to all users in this database and is
effectively 'Live'

®= Not Active: This Rule is no longer Active, therefore despite it remaining in the Defaults, it is
never triggered. Use this to temporarily turn off this rule.

O Restricted User: (Must be specified if Rule Status is set to 'Restricted User')Specify a User that this rule
will only be Active for. This allows you to test this rule before committing it to the 'Live' environment.

Examples:

On Insert when Blank:

Suppose we want to default the field SALESPERSON value to " Jane Steel" if that field is left blank when a new

Customer is added.
Table Name || Field Name Default Default From Clause|| Conditional Restricted
When Field Value Clause User

CUSTOMER ||SALESPERSO|[ On Insert Jane Steel Active For
MASTER N when Blank All Users

Suppose we want to default the field ADDITIONALFIELD_1 value to " 12345" if that field is left blank when a

new ltem is added.
Table Name || Field Name Default Default From Clause|| Conditional Restricted
When Field Value Clause User

ITEMMASTE [[ADDITIONAL|| On Insert 12345 Active For
R FIELD_1 |[when Blank All Users

Suppose we want to default the field ABCCLASS value to " A" if that field is initially blank and if the Analysis
Group is set to 'Materials' when a new Item is added.

ble Name || Field Name Default Default Fr mCIause Con onal Restrlcted
When Fleld Value Clause User

ITEMMASTE || ABCCLASS On Insert ITEMMASTE || ITEMMASTE || Active For
R When Blank R R.ANALYSISG|| All Users
ROUP =
'Materials'

On Insert and Update when Blank:
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Suppose we want to default the field JOBCATEGORY value to " Repair" if that field is left blank when a new Job
is added or updated.

JOBHEADER || JOBCATEGO || On Insert Repair Active For
RY and Update All Users
when Blank

Suppose we want to default the field SALESPERSON value to " Jane Steel" if that field is left blank and when the

Customer Region is set to 'Asia' when a new Customer or updated.
Table Name || Field Name Default Default From Clause|| Conditional Restricted
When Field Value Clause User

CUSTOMER [[SALESPERSO|| On Insert Jane Steel CUSTOMER [[CUSTOMERR]| Active For
MASTER N and Update MASTER EGIONCODE|| All Users
when Blank = 'Asia’

Suppose we want to default the Job field SALESPERSON value to " Bob Drum" if that field is left blank and when
the Job Customers Customer Type is set to 'Services' and where the Job Category is set to 'Plumbing' when a
new Job Order is Created or updated. (Note the optional use of an alias of 'CM' on the CUSTOMERMASTER

table)
ble Name || Field Name Default Default Conditional Restricted
When eld Value Clause User

JOBHEADER

SALESPERSO
N

On Insert
and Update
when Blank

Bob Drum

JOBHEADER,
CUSTOMER
MASTER CM

JOBHEADER.
CUSTOMER =
CM.CUSTOM
ER and
CM.CUSTOM
ERTYPE =
'Services'
and
JOBHEADER.J
OBCATEGOR
Y:
'Plumbing’

Active For
All Users

Suppose we want to default the Job field ADDITIONALFIELD_1 value to the current Customer Region field value
of the Job Order Customer if that field is left blank and when the Job Category is set to 'Plumbing' when a new

Job Order is Created or updated.

Table Name

Field Name

Default Default From Clause
When Field Value

Conditional Restricted
Clause User

JOBHEADER

ADDITIONAL
FIELD_1

On Insert
and Update
when Blank

[CUSTOMER

MASTER.CUS

TOMEREGIO
NCODE]

JOBHEADER,
CUSTOMER
MASTER

JOBHEADER.
CUSTOMER =
CUSTOMER
MASTER.CUS
TOMER and
JOBHEADER.J
OBCATEGOR
Y:
'Plumbing'

Active For
All Users

On Insert Always:
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Suppose we want to force the field Workflow Status value to "Goods In Picking" when a new Sales Delivery is

created.

Update 243 Testing

SALESDELIVE
RYHEADER

WORKFLOW
STATUS

On Insert
Always

Goods In
Picking

Active For
All Users

Suppose we wish to influence the Job Order Status when we create a new Job for an Asset which has an Asset
Type = 'Equipment'. In this example after the order is initially created we will update the Order Status to

'Quote' if the Condition is met.

Table Name

Field Name

Default
When

Default From Clause
Field Value

Conditional Restricted
Clause User

JOBHEADER

ORDERSTATU
S

On Insert
Always

Quote

JOBHEADER,
CUSTOMERA
SSETMASTER

JOBHEADER.
CUSTOMER =
CUSTOMERA

Active For
All Users

SSETMASTER
.CUSTOMER
and
JOBHEADER.
PROJECTORA|
SSET =
CUSTOMERA
SSETMASTER
.CUSTASSETN
AME and
CUSTOMERA
SSETMASTER
.CUSTASSETT
YPE =
'Equipment’

On Insert and Update Always:

Suppose we always want to force a field value of "Assembly" to the SOURCEDBY field if the Item Category =

'Wagons'
Table Name || Field Name Default Default From Clause|| Conditional Restricted
When Field Value Clause User
ITEMMASTE || SOURCEDBY || On Insert Assembly || ITEMMASTE ||ITEMMASTE Active For
R and Update R R.TEMCATE All Users
Always GORY =
'Wagons'

User Defined Validations

File-> Customisation Configuration -> User Defined Validations

The idea of this feature is to allow you to defined default field validation rules. This can be useful when setting up
new records be they Customers, Supplier, Items etc.. These User Defined Validations are run both or either
(depending upon the setting selected) when a new record is either 'Inserted' into the database or when an existing
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record is Updated.

This feature can be used to check for no entry of a field value or check to see if the field value meets a specific
condition or value. Unlike Required Fields which only check for a field value, this feature provides far more
detailed conditioning. This avoids the need for defining Required Fields, Custom Triggers and Screen Data Scripts
in order to force field validation of a blank field value.

An example of this is if you creating or updating an item and if the item Category was either 'Accessories' or
'Fasteners' then the Analysis Group for that item must not be left blank.

Note:

Hints:

Fields:

When defining a 'From Clause' and 'Conditional Clause' that relate to more than one table, you must
prefix each field name with the Table Name

eg: CustomerMaster.SalesPerson (aliases may be used to abbreviate table names 'OTHER' than
Primary Table Name)

These rules are run whenever a record is either inserted or updated in the database. This includes
records being entered or amended via external sources eg: Data Imports or API

Ostendo runs User Defined Defaults, Validations and Actions in the following sequence
1. User Defined Defaults
2. User Defined Validations
3. User Defined Actions

When defining a User Defined Validation with 'From and Conditional' Clauses it is suggested you first
test your syntax in the Data Spreadsheet (General -> Data Spreadsheet) feature of Ostendo prior to
implementing the validation rule.

eg:

Select ITEMMASTER.ANALYSISGROUP from ITEMMASTER where ITEMMASTER.ITEMCATEGORY IN
('Accessories','Fasteners')

When checking for a blank entry (eg: Null or blank) it is suggested you use the "coalesce" function
and condition this with two single quotes, then condition based upon the 2 quotes. This caters for
fields that may contain a space or a null (uninitialised value). A coalesce is not needed if the field
you are conditioning is a Lookup value or a Domain value.
eg: (coalesce(CUSTOMERMASTER.CUSTOMEREMAIL, ") =")  (The coalesce guards against the
possibility of a 'blank' existing in the email field)

Most rules will be defined to raise an error either on Update Only or on Insert or Update. However
for completeness we have provided additional rules to cover off numerous scenarios when
conditions are either met or not met.

Example of using User Defined Defaults alongside User Defined Validations.

=  Suppose you are importing Job Orders from a Web Source (outside of Ostendo) and that web
source does not provide for a job category. You could create a Job Category called
'Undefined' and then set a User Defined Default to use this field value when inserting a Job
Order of a specific Job Type eg: 'Web Order'.

®= Then setup a Validation rule that forces the user to update the Job Category to a another
category when the Job Category = 'Undefined' when the Order is Updated later. This will
allow the initial creation of the order without stopping the import process if there is no Job
Category within the import data.

O Table Name: Drop Down and select the Table Name of the Field you wish to define the Validation

O

against
Field Name: Drop Down and select the Field Name of the Field you wish to define the Validation
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against

O Validation Style:
*  Raise Error if Condition is met on Insert Only
=  Raise Error if Condition is not met on Insert Only
*  Raise Error if Condition is met on Update Only
=  Raise Error if Condition is not met on Update Only
=  Raise Error if Condition is met on Insert or Update
*  Raise Error if Condition is not met on Insert or Update

O Validation Message: This is the message the user would see when this validation is triggered and the
condition is met.

O From Clause: Specify the Table Name(s) to be used in the Conditional Clause (This can be left blank if
only one table name is conditioned and that table name is the same as the TABLENAME selected.,
however it is good practice to define the table name irrespective)

O Conditional Clause: Specify the conditioning syntax from the 'where' clause in the SQL.
O Rule Status: These options allow you to control the Status of this rule.

=  Restricted to User: (Default) Select this only to allow a specific user to test this Validation
before it is released to all Users. (This is used in conjunction with the Test User Option)

=  Active For All Users: This Rule is now available to all users in this database and is
effectively 'Live'

®=  Not Active: This Rule is no longer Active, therefore despite it remaining in the Validations, it
is never triggered. Use this to temporarily turn off this rule.

O Restricted User: (Must be specified if Rule Status is set to 'Restricted User')Specify a User that this rule
will only be Active for. This allows you to test this rule before committing it to the 'Live' environment.

Examples:

Suppose we want to force the user to enter a Primary Supplier when they create a new Item that has a
Category of 'Fasteners'

Style Message Clause User
ITEMMASTE || PRIMARYSU || Raise Error || A Supplier || ITEMMASTE [|(coalesce(IT || Active For
R PPLIER if Condition|| must be R EMMASTER. All Users
is met on |[specified for PRIMARYSU
Insert Only Items PPLIER, ") =
Categorised ") AND
as ITEMMASTE
Fasteners R.ITEMCATE
GORY =
'Fasteners'

Suppose we want to force the user to enter an an Email Address if the Email Address field is left blank when

creating a new customer
ble Name ||| Field Name ||| Validatio Validation [|From Clause|| Conditional Restricted
Style Message Clause User

CUSTOMER ||CUSTOMERE|| Raise Error Email CUSTOMER ||(coalesce(C || Active For
MASTER MAIL if Condition|| Address MASTER |[|USTOMERM All Users
is met on must be ASTER.CUST
Insert Only entered OMEREMAIL,
" =")

Suppose we want to force the user to enter an an Email Address if the Email Address field is left blank when

14137
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creating or updating a customer

Table Name | Field Name || Validatio Validation [|From Clause|| Conditional Restricted
Style Message Clause User

CUSTOMER ||CUSTOMERE|| Raise Error Email CUSTOMER ||(coalesce(C || Active For
MASTER MAIL if Condition|| Address MASTER [[USTOMERM All Users
is met on must be ASTER.CUST
Insert or entered OMEREMAIL,
Update ") <>")

Suppose we want to force the user to enter a Primary Supplier when creating or updating an existing item that
has a Category of 'Fasteners'

Style Message Clause User
ITEMMASTE || PRIMARYSU || Raise Error || A Supplier || ITEMMASTE [|(coalesce(IT || Active For
R PPLIER if Condition|| must be R EMMASTER. All Users
is met on |[specified for PRIMARYSU
Insert or Items PPLIER, ") =
Update |[Categorised ") AND
as ITEMMASTE
Fasteners R.ITEMCATE
GORY =
'Fasteners'

User Defined Actions

File-> Customisation Configuration -> User Defined Actions

The concept here is that you can define an Insert Action to be triggered after a condition is met. Typical examples
of this could be when the condition is met:

Create a new record in a table

Initiate an Email to be sent

Create a Call Ticket

Create a History Note and much more......

o O O O

The Action is defined as an Insert SQL Statement along with the Conditional Clause which triggers the Action.

Note:

O  When defining a 'From Clause' and 'Conditional Clause' that relate to more than one table, you must
prefix each field name with the Table Name
eg: JobHeader.SalesPerson (aliases may be used to abbreviate table names 'OTHER' than Primary
Table Name)

O These rules are run whenever the Conditional Clause is met

O  Ostendo runs User Defined Defaults, Validations and Actions in the following sequence
1. User Defined Defaults
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Hints:

Fields:

2. User Defined Validations
3. User Defined Actions

When defining a User Defined Action with 'From and Conditional' Clauses it is suggested you first test
your syntax using a select statement in the Data Spreadsheet (General -> Data Spreadsheet) feature
of Ostendo prior to implementing the Action rule.

When checking for a blank entry (eg: Null or blank) it is suggested you use the "coalesce" function
and condition this with two single quotes, then condition based upon the 2 quotes. This caters for
fields that may contain a space or a null (uninitialised value). A coalesce is not needed if the field
you are conditioning is a Lookup value or a Domain value.
eg: (coalesce(CUSTOMERMASTER.CUSTOMEREMAIL, ") =")  (The coalesce guards against the
possibility of a 'blank’ existing in the email field)

Only Insert SQL Statements can be defined. When defining the fields to be inserted as Field Values,
always ensure these fields are enclosed in square brackets. Any literals can simply be enclosed in a
single quote.

For Technical Users Only: Whilst the Insert Statement field only allows for the INSERT SQL function,
you can also call a Store Procedure from an Action. Instead of the standard 'INSERT INTO' syntax, you
would write the following statement if you were calling a procedure (ProcedureName) that requires
parameters eg: the field name CUSTOMER and CREDITTERMS AND a literal of 'ABC'
EXECUTE PROCEDURE PROCEDURENAME [CUSTOMERMASTER.CUSTOMER],
[CUSTOMERMASTER.CREDITTERMS],'ABC'

Table Name: Drop Down and select the Table Name of the Field you wish to define the Action
condition against

From Clause: Specify the Table Name(s) to be used in the Conditional Clause eg: ITEMMASTER

Conditional Clause: Specify the conditioning syntax from the 'where' clause in the SQL. eg:
ITEMMASTER.ONHANDQTY <0

Insert Statement: INSERT INTO OSTDEF_NEGQTYS (ITEMCODE,ONHANDQTY) values
(ITEMMASTER.ITEMCODE], [ITEMMASTER.ONHANDQTY])

Action When: This is when the Action will be applied from the stated Table Name
=  On Insert and Update (Default)
* On Insert Only
®=  On Update Only

Rule Status: These options allow you to control the Status of this rule.

* Restricted to User: (Default) Select this only to allow a specific user to test this Action
before it is released to all Users. (This is used in conjunction with the Test User Option)

=  Active For All Users: This Rule is now available to all users in this database and is
effectively 'Live'

®= Not Active: This Rule is no longer Active, therefore despite it remaining in the Actions, it is
never triggered. Use this to temporarily turn off this rule.

Restricted User: (Must be specified if Rule Status is set to 'Restricted User')Specify a User that this rule
will only be Active for. This allows you to test this rule before committing it to the 'Live' environment.

Examples:

Suppose we have a custom table that records instances of items where the Quantity on Hand was less than
Zero at the point the Item Master was Updated. When that condition is met, the Action rule will insert a record
into the Custom Table.
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Table Name Conditional Insert Restricted
Clause Statement User

ITEMMASTER On Update ITEMMASTER |[ITEMMASTER. |[INSERT INTO Active For All
Only ONHANDAQTY <||OSTDEF_NEGQ Users

0 TYS
(ITEMCODE,O
NHANDQTY)
VALUES
(ITEMMASTER
.ITEMCODE],
[ITEMMASTER.
ONHANDAQTY])

Suppose we wish to create a new Call Ticket when a new Customer is created. Note: In this example there is no
Conditional Clause as we want this to occur for every new customer that is created.

Table Name ||| Action When || From Clause || Conditional Insert Restricted
Clause Statement User

CUSTOMERMA|| On Insert ||CUSTOMERMA INSERT INTO || Active For All
STER Only STER CALLNOTES Users
(CALLMETHOD,

CALLDATE,CALL
TIME,CALLSTAT
US,COMPANYT
YPE,COMPANY
NAME,CALLBRI
EFDESCRIPTIO
N) VALUES
(‘Phone’,'now’,
'now','Open’,’
Customer',
[CUSTOMERM
ASTER.CUSTO
MER],'Send
out
Information
Pack')

Help Files

All Help Files have been moved from a CHM to an HTML format. Along with this, these Help Files are now located
in the Cloud. This achieves a number of benefits:

1. Updating of Help Documentation by Development-X can be more regularly accomplished.
Amendments can be published without delay.

2. New functionality can be explained in an improved manner

3. With previous versions of Ostendo where the Help Files were located on a Local Server or PC. In
some high secure environments, the CHM files could be prevented from being launched. Now the
documentation is online and available via a browser, there should not be any security issues.

4. Under the menu option Help -> Release Notes, we now direct you to a Table of Contents of our

Release Notes Help Files. This will allow users to easily find information relating to their current
release along with some previous Major Releases.
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As with the Previous Help Files, screens directly linked to Help Topics can easily be accessed by the
user by pressing 'F1' This will launch their browser and display the HTML Help Page relevant to the
screen they are on. eg: Pressing F1 from the Items screen will launch the Item Help page from the
Reference Help.

The current Reference Help has not been finalised, therefore the current Ostendo Helps Files do not
yet reflect Update 243 functionality

Business Process Models

Ostendo now offers the ability for sites to document Business Processes directly from within Ostendo. While
Ostendo has its own proprietary Help, it has always been difficult for users to capture and make available their
own internal business processes that are used in conjunction with Ostendo. Typically these processes are
captured in Word documents that have always been stored and maintained outside of Ostendo. This new concept
stores the Business Process within the database, which means they are always available to users within or
associated with that organization (e.g., customers or suppliers).

Benefits

Benefits of capturing a Business Process and storing it within Ostendo include:

o

If users leave the organization, the knowledge is lost. Documented Business Processes allow you to
fill that knowledge gap.

Organization documentation is not easily maintained (external files get lost or are never
maintained).

New Ostendo users can follow documented Business Processes that are specific to the organization.

Ease of access to this documentation. Anyone with appropriate security can easily access this
documentation.

Easily produce detailed documentation without the need for advanced technical skills or tools.

Important Note

This feature is currently functional; however, further development of its features will be extended in the near
future after the Public Release. This Pre-Release version of Ostendo at least gives you the opportunity of setting up
and capturing Business Processes so you can see the power of this new feature. The viewing capability will be
included for the Public Release.

Future Development

Future development includes:

O Development of outputs allowing users to view the documented Business Process via:

= A new tab on the main screen of Ostendo (similar to tabs for Workflows and Tiles) for
viewing (to be available before Public Release)

= PDF



=  HTML Web Page
O Extending this capability to Items, Descriptors, BOMs and other areas of Ostendo
O Enhanced user security around the Business Process Capture mode (Ctrl-F1)
O  User security around viewing mode of the Business Process
O Version Status (Draft or Approved)

O  Approval Date

Overview

When capturing a business process you should consider breaking this into four parts:
1. Defining the Business Process Name
This is simply the record that holds all documentation relating to this process, including:
O Categorising that Process
O Determining the visibility/availability of that process to users
2. New Step Process (Ctri-F1)
From within Ostendo allowing the initial capture of information, including:
O  Screen shots
O Notes
3. Editing of the Recorded Business Process
Here we focus on "cleaning up" the captured content and the presentation, including:
O  Resequencing of steps
O  Editing of notes
O  Preparing notes to be presented in an HTML format

4. Making the Business Process Available

Making this Business Process available to users in either a PDF document or web page format, or directly from
within Ostendo via a Business Processes tab (similar to tabs for Workflows and Tiles).



Business Process Capture

- Enter Process Name

- Enter Process Description
- Link to Category (optional)
- Enter Version # (optional)

Create The

Business
Process
Record

il Navigate to the
relevant
o d
screen for
capture

Invoke New
Process Step
Mode
(Ctrl-F1)

Screen Image
Automatically
Captured

aptur@;\hs Type Process

Notes? Step Notes

Y

/@ Steps

Required?

Edit Captured

Business Process Categories:

General -> Settings -> Process Categories

Business
Process

Review Step
Sequence &
Adjif
required

Review Step
Notes and
Adj if

required

Add any
External
HTTP Links

Make Business Process
available to Users

This screen is used to define optional Business Process Categories allowing you to logically group Business

Processes together. eg: Sales, End of Month, Purchasing etc...



Business Processes

General -> Business Processes

This new screen has been developed to allow the initial creation of the Business Process model. This screen is
made up of three tabs:

List Tab:

Buttons:

Close: This will close the Business Processes screen. If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Business Process.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the Business Process from this table

Detail Tab:

o O O O

Steps Tab:

Process Name: Enter the name of the Business Process
Process Description: Enter a Description of this Business Process
Process Category: (Optional) Browse and select a Process Category to link to this Business Process

Process Notes: Type some general notes about this Business Process.

The contents of each step are automatically populated from the "New Process Step" mode (Ctrl-F1) in Ostendo
when the process is being initially captured on screen.

Typically, you would use this tab when editing pre-captured information.

O

o

Sequence: This number is automatically generated from each screen from the "New Process Step"
mode (Ctrl-F1). Amend the sequence number as required to re-sequence steps.

Step Style:
=  Screen: When adding Steps from Ctrl-F1 as screen shots
®=  Note: When adding Steps from Ctrl-F1 as text notes

Step Description: Type in a description relating to this step
Step Notes: These are plain text notes capture from Ctrl-F1 and can be edited directly in this field.

Step HTML Notes: use a free online HTML Editor tool eg: https://html-online.com/ to create the HTML
code by copying your text from the Step Notes field and pasting it into the WYSIWYG editor screen,
formatting it (bold, colour etc).. then copying back the generated HTML code into this field

Image: This will appear as a thumbnail icon. Click on this icon to enlarge the image for viewing


https://html-online.com/
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O Ostendo Help Link: By default Ostendo will automatically embed its own Help URL link here based on
the screen you captured
O External HTTP Link: This is where you can store a URL link to an external source eg: YouTube video or
external document etc.. NB: One link is allowed per step.
O  Custom Screen Rules: By default Ostendo will expose the Custom Screen Rules relating to the screen
you have captured the image from. These screen rules relate to:
*=  User Defined Defaults
=  User Defined Validations
*  User Defined Actions
List Tab
) Business Processes
List  Detail  Steps
Process MName 7| Process Description Process Categon Wersion
#|Sales Order Process | Sales Order Process Standard
Detail Tab

=) Business Processes

List Detal Steps

Process Hame Deszcription
Prozess Categary Wersian
Standard Fe 0=
Motes
Steps Tab
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Lo = a X
List  Detal Steps
Process Name: Sales Oider Process Close:
Sequence Step Style Step Desciption Step Notes Step HTML Hotes Image Estemal HTTP Link Custom Sereen Rules P
10|Screen Creation Screen Select the Customer and amend any dates a| <p>Select the</p> = B
» 20 Screen Header Infomation Enter a Description for this Order <p>Enter a cstrongyDescriptions /strong> for this 0 = [ save
30| Soreen Lines Prsss F5 to Add 2 new line and sellot the Ce = ) Cancel
K Delete

Example Only

Default Values
Default Value 1 for TEMMASTER.ITEMDESCRIPTION is "Barcode 1" [On Insert and Update when Blank) where itemmaster.itemcode =

mmaster.itembarcode = "BC1" [Active for All Users]
> Default Value 2 for TEMMASTER.TEMDESCRIPTION is "Barcode 2" [On Insert and Update when Blank) where itemmaster.itemcod
itemmaster.itembarcode = BC2" [Active for All Users)
Validation Rules

alidation Rule 1 for TEMMASTER is “Raise Error if Condition is met on Update Only" displaying message "Supplier Blank" for the following: [coalesce
(ITEMMASTER.PRIMARYSUPPLIER, ") =) AND ITEMMASTER.TEMCATEGORY = 'Fasteners’ [Active for All Users)
‘Conditianal Actions
> Action Rule-1 for ITEMMASTER [On Insert and Update)is "insert into astdef_negqtys (itemcode,onhandqty] valuesi[itemmaster.itemcode],
[itemmaster.onhandqty])" for the fallowing: ITEMMASTER.ONHANDQTY <0 [Active for All Users)

Clicking on the Image thumbnail will display the relevant screen for that Step.

@ Business Processes

List  Detail Steps
Process Name: Gales Order Process

Sequence Step Stle Step Diescription Step Nates Step HTML Notes Image External HTTP Link, Custom Sereen Fiules
20 Scieen Heade! Information Enter a Desaription for this Drder <p>Enter a <stiong: Desariptiond/strongs for this C
30/Sereen Lines Frsss F6 to.Add a new line and select the C, e e Cranhy

Customer Purchase Order
£ 4

Order Date Required Date List Code

12/09/2025 v  12/09/2025

© Create New Sales Drder

Sales Type Order Mumber Sales Style
CounterSales P ke
Fiertal Statt Rental Erd

O Copy Sales Drder from anather Drder

Select Existing Orcer Number for Copy

Order Humber Piicing Method

Selected Quate Number

Create Quote Create Oider Cancel

oK Cancel

Two Bin Stock Control

We have introduced the Two Bin/Kanban concept into Ostendo, typically used for low-value, high-volume items
that still require stock control. Previously, all items were treated the same way (full perpetual control), where
stock replenishment requirements were generated based on demand and supply, using re-order quantities,
multiples, minimum levels, and history days.

High-volume, low-value items (e.g. consumables) are essential to manufacturing or jobbing environments and
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must never run out, as this could jeopardize the entire process. However, treating these items the same as higher-
value inventory (full perpetual control) requires additional administration.

These consumable items may be backflushed to maintain stock on hand but need to be reordered via Inventory
Replenishment to maintain adequate stock levels. Typically, these items are sourced locally and do not have long
lead times.

Items marked as "Two-Bin" will be excluded from the Inventory Replenishment and Order Inventory Availability
functions. The re-ordering and issuing process is triggered when a bin is emptied via a new screen called "Two-Bin
Replenishment."

How A Two Bin System Works:

The Two Bin concept uses two bins, one placed in front of the other. When the first bin is emptied, the second bin
(which contains stock to cover typical demand over the item's supply lead time) moves to the first bin's position.
The empty first bin triggers re-ordering of replacement product. When received, the stock goes into the empty bin
and is placed behind the current bin.

This simple concept prevents the factory from running short of product and provides timely notice when more

product is required. However, while this process simplifies re-ordering, it can potentially lead to higher stock
holdings.

Two-Bin Inventory System

_________________________

REORDER PROCESS

BIN 2
(Reserve)

1. Bin 1 becomes empty
2. Switch to Bin 2
3. Trigger reorder
4. New stock refills Bin 1

\_‘___-_._-/
Lead Time Period

_________________________

l

Daily Usage

Key Characteristics

+ Bin 1 quantity = Expected demand during lead time

+ Bin 2 quantity = Expected demand during lead time

+ Total inventory = 2 % Lead time demand (We would also recommend a warehouse safety stock level)
+ Risk: Stockout possible if unexpected high demand or lead time extends

Implementation in Ostendo
To reduce items from inventory, Ostendo currently allows:
e  Backflushing items to deplete stock on hand
e  Manual issuing of items to deplete stock on hand
Because Ostendo allows backflushing and manual issuing, these transactions must be considered when an empty
bin is returned for reordering. We maintain a running total for each bin, determine what has been issued versus

the bin quantity, and write off the difference as material usage with a type of "ISSUE."

Each physical bin is defined with its own quantity, which can default to the item's "Re-Order Qty" or use a specific

24137



override quantity. The issue warehouse and location for each bin is also required.

Although different locations can be defined for different bins, this is not required. When determining bin issues
(upon return of empty bin), we examine total issues for the entire warehouse.

Process Flow

When an empty bin is returned for reordering, a user scans a barcode (or manually enters the bin barcode) into a
new screen, which triggers:

1. Order Requirements Creation: An Order Requirements record is created to replenish stock for that
specific bin quantity. The normal process of generating a Purchase Order from this requirement
follows (using the Create Required Orders screen).

2. Inventory Transaction: An Inventory Transaction is generated to write off the bin's quantity less any
previously recorded backflush or manual issues at the warehouse level. This accounts for other
picking or backflushing processes, ensuring we don't over-issue since the last bin re-order.

3. Running Balance Maintenance: A running balance for Two Bin inventory records is maintained in a

new Two Bin inventory table tracking what has been issued outside the Two Bin replenishment
system.

Example Scenario

Item ABC
O  Stock on Hand: 2,000 units spread across three bins plus safety stock

O Safety Stock in Main Warehouse/Location: 1,100 units (maintains enough stock to supply each
factory bin, including supplier lead time)

Bin Configuration:
O  Bin 1: Override Re-Order Qty of 500
O  Bin 2: Re-Order Qty of 150
O Bin 3: Re-Order Qty of 250

Scenario 1: Bin 3 Runs Out

When the operator with Bin 3 runs out of stock:

1. They return the empty bin to the warehouse and pick up another bin with the same re-order quantity
(250)

2. The empty bin is scanned to identify the specific bin and its re-order quantity

This triggers:
O  Order Requirements record creation for 250 units
O Inventory Transaction to write off the bin quantity less any previous backflush/manual issues
O Running balance update in the Two Bin inventory table

Scenario 2: Bin 1 Runs Out

When the operator with Bin 1 runs out of stock:



1. They return the empty bin to the warehouse and pick up another bin with the same re-order quantity
(500)

2. The empty bin is scanned to identify the specific bin and its re-order quantity

This triggers the same three processes as Scenario 1, but for the 500-unit quantity specific to Bin 1.

Item Rules

Inventory -> Items -> Settings -> Item Rules -> Assembly BackFlush Policy

Two new Assembly BackFlush Policies have been added to the "Assembly BackFlush Policy" Inventory Rule to
enable BackFlushing to occur for Two Bin Item components only.

Assembly BackFlush Policy Options:

O  Item Specific (default): This existing rule is also used in conjunction with the Item setting (Additional
Inventory Settings on Item Master screen) of "BackFlush Issues on Assembly Receipt". This enables
selected manufactured items to BackFlush 'ALL' components when that manufactured item is
receipted from an Assembly Order.

O  All Items: This existing rule enables all manufactured items to BackFlush 'ALL' components when any
manufactured item is receipted from an Assembly Order.

O  Item Specific Two Bin Components Only: This new rule is also used in conjunction with the Item
setting (Additional Inventory Settings on Item Master screen) of "BackFlush Issues on Assembly
Receipt". This enables selected manufactured items to BackFlush 'ALL' components marked as "Two
Bin" when that manufactured item is receipted from an Assembly Order.

O  All Items Two Bin Components Only: This new rule enables all manufactured items to BackFlush 'ALL'
components marked as "Two Bin" when any manufactured item is receipted from an Assembly Order.

Note: If the Assembly Rule of "Only BackFlush Remaining Issues" is selected, then the BackFlush Qty's will be
further evaluated before being BackFlushed.

Items Screen

Inventory -> Items

Selected individual items are marked as Two-Bin by a new option in the ReOrder Basis field called "Two-Bin". The
Level Qty field and Qty Multiple are then no longer available.

NB: Just like turning on variant tracking (eg: serial, batch etc..), Two-Bin can only be selected if that item has Zero
Stock On Hand

Any Item Master records will automatically have their ReOrder Basis field updated to Two-Bin if this is amended
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on the Item Master screen.

iy Bills of Material | Itern Site Master | ad| Itermn Images @ Item Site Settings ] Itern Properties | [ Item Units | Item
List Detai
Item Code LImit Inventory Information
d o # Orhand I]ty Supply Oty  Demand I]Iy
Descrption AQ\ ﬂuallab_L
Testingl Relrder Basic //naml [ty ReOider [my] ’ﬁl_l,- Multiphe
Barcode Status Fixed Oty E i
344234 Ative - Fixed Oty '“‘—" Lea ir]':
; History Days id £ il
Settings | Manu Info | Order Dims  Budget | Times Da:lh' Forecast
Categorny . Sub Categorny F"u:cimsin; i
F 3 # &
Pncing Group T ax Growp Additional lrvenbory Settings:
Sample 47 & NONTAXABLE 74 Item Pricing & Costing
Analysiz Group Default Supply Method Sell Price 5P [inc Tax) Buy Price
& | Supply from Stock - $0.000000 | $0.000000 | $0.000000 | Pricing Costing

Aurhual Cretinn is sed

Categories

Inventory -> Settings -> Categories

A new option is available to each Category to indicate if all items with that Category are either "Two Bin" or
"Perpetual". This is an optional way of turning "Two Bin" on en-mass for all items in a specific Category.

O If Two Bin is selected, then 'ALL' items (except any variant tracked eg: Serial or Batch etc..) with that
Category are automatically updated with a ReOrder Basis of "Two Bin"
NB: Just like turning on variant tracking (eg: serial, batch etc..), Only Items Two-Bin can only be
selected if that item has Zero Stock On Hand

O If Perpetual (default value) is selected, then 'ALL' items (except any variant tracked eg: Serial or Batch
etc..) with that Category are automatically updated with the ReOrder Basis of "Fixed Qty"

Sub Categories

Inventory -> Settings -> Sub Categories

A new option is available to each Sub Category to indicate if all items with that Sub Category are either "Two Bin"
or "Perpetual”. This is an optional way of turning "Two Bin" on en-mass for all items in a specific Sub Category.

O If Two Bin is selected, then 'ALL' items (except any variant tracked eg: Serial or Batch etc..) with that
Sub Category are automatically updated with a ReOrder Basis of "Two Bin"
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O If Perpetual (default value) is selected, then 'ALL' items (except any variant tracked eg: Serial or Batch
etc..) with that Sub Category are automatically updated with the ReOrder Basis of "Fixed Qty"

Two Bin Master

Inventory -> Two Bin Master
This is where we defined each bins characteristics eg: bin sizes (ReOrder Qty), specific locations, and its own
barcode. If there are multiple bins in use for an item, and those bins contain the same ReOrder Qty and Locations,

then only one record needs to be defined. Any differences in bins relating to ReOrder Qtys or Locations will require
an additional record to be added here

List Tab

The opening list will only display all items where the ReOrder Basis is set to "Two Bin".

Detail Tab

Add Button:

Press the Add button to create a new Bin record

O Barcode: Enter any combination of characters to uniquely identify this Bin. This barcode is used to
identify the empty bin when it is returned to trigger a re order of product

O Warehouse Code: This is the Warehouse linked to this specific bin. (NB: This can simply be defined
as the default Warehouse for this item if individual bin stock control is not required)

O Location Code: This is the Location linked to this specific bin. (NB: This can simply be defined as the
default Location for this item if individual bin stock control is not required)

O Bin Quantity From: ReOrder Qty (default value) or Override Qty:

= ReOrder Qty: If this is selected, the item (or item site master) records ReOrder Qty is
assumed to be the Bin ReOrder Qty.

=  Override Qty: If this is selected, the ReOrder qty for this bin is deemed to be different than
the ReOrder level for the item. This allows you to have bins containing different default
qty's.

O Override Qty: Enter the bin gty here if the Override Qty option was previously selected above.

Two Bin Replenishment

Inventory -> Two Bin Replenishment

This screen allows the user to scan (or manually enter) the empty bin Barcode, which will trigger the following:



O  An Order Requirement will be generated automatically for the Bin Qty against the Supplier held on
the Item Master (or Item Site Master in the case of Multi Site Inventory). A user can then run the
Create Required Orders screen to generated the required Purchase Order.

O  Any Assembly BackFlush Issues or Manual Issues (including Job Picking, Sales, POS or Inventory
Adjustments of ISSUE Types) of that item (with a matching warehouse) are totalled since the last time
the bin was emptied. Ostendo will determine the difference between the Bin Qty and the total Issue
Qty and automatically create a stock transaction for that difference, with an Adjustment Source of
"TWOBINISSUE" and use the Adjustment Type of "ISSUE". Therefore we do not over issue since the last
bin re-order.

O A running balance for Two Bin inventory records is maintained behind the scenes.

User Login & User Security

Ostendo now allows for new usernames to be 100 characters long instead of 30 characters. This allows for much
longer usernames or email addresses to be used to identify users rather than a short code name.

Your Username automatically populates into the Login Username field upon logging into Ostendo. This will be
based upon the last person to log into Ostendo from that same client machine.

Password Strength Logic

Special Note - Existing Passwords From Previous Ostendo Versions:

For sites migrating from a previous version of Ostendo where this new Password functionality did not exist, they
can choose to implement advanced security or simply continue using their present password structure. Advanced
Password options are either activate or inactive for a site in total.

Enforced Changed of Initial Password:

The concept of Password strength has been included with Update 243. Previously when the default password of
'pass’ was initially set, users were never be forced to change this password which could leave sensitive areas of
Ostendo exposed to users who should not have authority accessing.

Now by default, once a user logs on with the password of 'pass', if there are any Password Strength rules defined,

Ostendo will force the user to change their password using the existing 'Change Password' screen (File -> Change
Password). This ensures that all users will not be using the default password of 'pass' when they log on in future

Password Strength:

Ostendo now has the concept of setting and using a global password strength. This ensures that when a user sets
their password, it is of enough strength the organisation requires.



A new screen 'Password Strength' screen (File -> System Configuration -> Password Strength) has been created for
Administrators to defined their organisations default password strength attributes.

The minimal password strength attributes can be defined as follows:

O Minimum Password Length: Minimum Password character Length (NB: The maximum length is 20
characters)

Requires Both Alpha and Numeric Characters: Select to force an Alpha Numeric password required
Requires Both Upper and Lowercase Characters: Select to force Upper and Lower case characters
At Least 1 Symbol Character: Select force at lease 1 Symbol character eg: |,@,%,5 etc.....

0O O O O

Default New User Password: This an override Default password to the standard password of 'pass’
that is used when resetting a users password or when a new user is created. If you have Password
Strength rules defined, ensure this default password 'Does NOT' meet these rules. This will ensure
the user must change their password.

NB: If turning on 'ANY' Password Strength rules for the first time, ensure existing users initially log on with their
existing password in UPPERCASE. They will then be prompted to change their current password if it does not meet
the current Password Strength criteria.

Inventory Availability

This screen has now been extended to Project out to 30 periods eg: 30 Days, 30 Weeks, 30 Months. Also the Qty on
Hand and Expected On Hand Qty are now highlighted in Red font whenever the qty goes below zero.

o]
@ ltems | —| Warehouses | =] Locations | [ Customise

List  Detal  Transaction History

F tion

Item Cod Unit J Y|
em Lode m Onhand Gty Supply Demand Available Free Oty
Drescription
Mext Supply Date Item Info
Barcode Status
Pack Sizes
Onhand Gty Supply Demand Available Free Oty

Projected Availability Settings
Period Length

Irvventory By location  Projected Availabilty — Order Details

22082025 22/09/2025 22A10/2025 2211/2028 2212/2025 22/00/2026 22/02/2026 22/03/2026 22/04/2026 22/06/2026 22/06/2026 22/07/2026 22/0¢

Oty on Hand a 2095 2095 -2905 -2905 -2905 -2905 -2905 -2905 -2905 -2905 -2905
[-] Sales Orders 5 1] 1] u] 1] 1] 1] 1] 1] 1] 1]
[-1POS 0 0 0 0 0 0 0 0 0

[-]Job Orders a a 5000 0 a a

[-] Azzembly |ssues 1] 1] 1] u] 1] 1]

[+] Purchase Qrders 2100 0 a 0 a a

[+] Azzembly Receipts 1] 1] 1] u] 1] 0 0 0

[-] Rentals Out a a a 0 a a a a

[+] Rentals In a a a 0 a a a a a a 1] a
Expected On Hand Gty 2095 2095 -2905 -2905 -2905 -2905 -2905 -2905 -2905 -2905 -2905 -2905

Log Screen Load Time

There is a new option on the System Settings ( File -> System Configuration -> System Settings - > Environment Tab)
to allow the recording of screen load times. This information enables administrators to monitor the time taken to
load certain screens within Ostendo enabling you to compare screen load times where there maybe a latency



issue for some users.

&
Compary Information  Enviranment Settings  Syster Mumbering  Accounting Link
" General
Hide Related Toalbar [

Enable Auto Complete on Lookups
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Email Client Outlook. - Prefis [ncl Signature

Advanced Searching &uto Collapze on Advanced Search | For a rult value ¢
Licence Matification ta Administration Users Only [

Location kap Link.  httped/maps. google. comd o=

Embed fontz when sawving or

Activate Screen Logging Log Screen Load Time Enable Databaze Me

Wordwrap column headings for [nguiny and Analysiz Yiews ||
Dynarnic Archive Dapz for Clozed and Updated Orders, mvoices & Paymentz IS=

Currenry Sumbinl Mwverride

Emailing Reports

Ostendo now uses its own Email application rather than utilising Outlook or other Email applications. The major
benefit of this is security permissions. Removing Outlook from the environment eliminates security and
compatibility issues when integrating with such applications.

HTTPS vs TCP/IP:

When emailing documents from Ostendo environments running an HTTPS protocol, we embed a link in our email
(rather than simply attaching a file). This means the recipient simply clicks on this link to open the file
automatically via their browser allowing them to Print and/or download the PDF file. Emails could potential
contain multiple links.

When emailing documents from Ostendo environments running an TCP/IP protocol, we must attached the
physical PDF file to our email. Links will not be included.

As we are using our own email application, we now store additional information relating to the User eg: Email
Signature, along with their Position, Mobile Number and other details that can make up a typical email signature.

If the user does not have a stored signature against their user record, Ostendo will automatically create a
standard email signature for that user. This default signature is generated 'on the fly' when the user emails a
document (eg: invoice etc..). This approach means that provide user details are complete, the user can generate
and send emails without having a custom signature.
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Example of the Standard Signature:

John Smith | Senior Marketing Manager
ABC Corporation

m: +1 (234) 567-8900 e: john.smith{@company.com w: www.company.com

Over and above User Signatures, we now have an optional 'Site' Signature that can be used instead of a specific
Users Signature. This Signature would be more generic to the organisation and maybe be better suited when multi
sites are in use.

ABC Corporation
123 Business Ave, Suite 100, City, State 12345

p: +1 (234) 567-8300 e: info@company.com w: www.company.com

User Security & Options

System Configuration -> User Security & Options -> Options tab
A number of new fields are available in this screen under the 'Email' option within the 'Options' tab

These fields will be used to automatically generate the default email signature that Ostendo generates 'on the fly'
if no HTML Signature exists for this User

O  Email Address

O  User First Name

O User Surname

O  User Mobile Number

O User Company Position
Example:
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John Smith | Senior Marketing Manager
ABC Corporation

m: +1 (234) 567-8900 e: john.smith{@company.com w: www.company.com

Creating and Setting a personalised HTML Signature

There is a new button on this screen "Set / View Html Signature" allowing you to specify HTML code to generate a
signature.

This screen is divided into an Upper section and Lower section

Ok
[ Paste

Upper Section:

Type or paste in your 'marked up' text etc HTML code for your signature. You can simply use a free online WYSIWIG
HTML editor to generate this code, then paste it into the upper section of this screen.

Lower Section:

Once you have pasted the marked up code in the upper section, it will show the HTML content in this Lower
Section.

Example:

(NB: The persons names and Company and other details are included in the mark up)

To create or modify the standard default signature for a user, paste in the contents below. (Amend the text shown
in blue as required)

<IDOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
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<meta name="viewport" content="width=device-width, initial-scale=1.0">

<title>Email Signature</title>
</head>
<body>

<l-- Ostendo Std Signature Version -->
<br>

<table cellpadding="0" cellspacing="0" border="0" style="font-family: Arial, sans-serif; font-size: 13px; color:

#333;">

<tr>
<td>

</div>
<div style="margin-bottom: 5px;">
<strong style="font-size: 15px;">John Smith</strong> | Senior Marketing Manager

</div>
<div style="margin-bottom: 8px; color: #666;">ABC Corporation</div>
<div>
<b>m: </b><span style="margin-right: 15px;">+1 (234) 567-8900</span>
<b>e: </b><span style="margin-right: 15px;">john.smith@company.com</span>
<b>w: </b><span>www.company.com</span>
</div>
<!-- Disclaimer -->
<div style="margin-top: 15px; padding-top: 10px; border-top: 1px solid #ecfOf1; font-size: 11px; color:
#95a5a6;">
This email and any attachments are confidential and may be privileged. If you are not the intended
recipient, please notify the sender and delete this message.
</div>
</td>
</tr>
</table>
</body>
</html>

Sample Output:

&) Html Code = (] o

KIDOCTYFE html>
<html lang="en"">

<head> Ok
<meta charget="UTF-8'">
<meta hame="viewport" content=""width=device-width, initial-zcale=1.0" |_|°‘l_| Paste

<itle>Email Signature« fitles
</head:>
<body>
¢1-- Ostendo Std Signature Yersion -

i3
<table cellpadding="0" cellspacing="0" border="0" style="fant-family: Arial, sans-senf; font-size: 13p; color: #333;"

John Smith | Senior Marketing Manager
ABC Corporation

m: +1 (234) 567-8900 e: jphn_smith@company.com w: www.company.com

Company Sites

General -> Company Sites -> Detail tab
This screen includes a new button allowing you to create a site HTML Signature that can be selected when
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documents are emailed from Ostendo

Example:

ABC Corporation
123 Business Ave, Suite 100, City, State 12345

p: +1(234) 567-8900 e: info@company.com w: www.company.com

Creating and Setting a Company Site HTML Signature

There is a new button on this screen "Set / View Html Signature" allowing you to specify HTML code to generate a
Site signature.

This screen is divided into an Upper section and Lower section

Ok
[ Paste

Upper Section:

Type or paste in your 'marked up' text etc HTML code for your signature. You can simply use a free online WYSIWIG
HTML editor to generate this code, then paste it into the upper section of this screen.

Lower Section:

Once you have pasted the marked up code in the upper section, it will show the HTML content in this Lower
Section.

Example:

(NB: The Company Name and details are included in the mark up)

To create a Site signature, paste in the contents below. (Amend the text shown in blue as required)

<IDOCTYPE html>
<html lang="en">
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<head>

<meta charset="UTF-8">

<meta name="viewport" content="width=device-width, initial-scale=1.0">

<title>Email Signature</title>
</head>
<body>
<l-- Ostendo Std Signature Version -->
<p>&nbsp;</p>
<table style="font-family: Arial, sans-serif; font-size: 13px; color: #333;" border="0" cellspacing="0"
cellpadding="0">
<tbody>
<tr>
<td>
<div style="margin-bottom: 5px;"><strong style="font-size: 15px;">ABC Corporation</strong></div>
<div style="margin-bottom: 8px; color: #666;">123 Business Ave, Suite 100, City, State 12345</div>
<div><strong>p: </strong><span style="margin-right: 15px;">+1 (234) 567-8900</span> <strong>e: </strong><span
style="margin-right: 15px;">info@company.com</span> <strong>w: </strong>www.company.com</div>
<!l-- Disclaimer -->
<div style="margin-top: 15px; padding-top: 10px; border-top: 1px solid #ecfOfl; font-size: 11px; color:
#95a5a6;">This email and any attachments are confidential and may be privileged. If you are not the intended
recipient, please notify the sender and delete this message.</div>
</td>
</tr>
</tbody>
</table>

Sample Output:

© Himl Code = (m}

<IDOCTYPE himls
<htrnl lang="en"">

<head> Ok
<meta charset="UTF-3":
<meta name="viewpor* content="width=davice-width, initial-scale=1.0" [B Paste

<litleE mail Signature< it
</head:
<body>
<l-- Dstendo Std Signature Yersion --»
<p>knbsp;</p>
<table style="Tont-tamily: Arial, sans-zerf; font-size; 13px; color #333," barder="0" celspacing="0" cellpadding="0">
amdin

ABC Corporation
123 Business Ave, Suite 100, City, State 12345

p: +1 (234) 567-8900 e: info@company.com w: Www.COmpany.com

Example Of An Email Generated From Ostendo
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& New Email Message X

Ta fred{@loopyplumbing, com

| & You can swap between your signature or
t -
Send that of your Site
Beco
Signature
O User () Site ubject:  Sales Invoice: 500043 From: Development-x Limited
To Fred

Pleaze find attached aur lnvaice 500049 dated 25/08/2025 far pour attention

Development-X Limited

To Fred

Please find attached our Invoice 500049 dated 25/08/2025 for your attention
The recipient simply clicks on the box
to view the Invoice via their browser

To view or download the report please click on the above button.

John Smith | Senior Marketing Manager
ABC Corporation

m: +1 (234) 567-8900 e: john.smith@company.com w: www.company.com

. development-x.com | info@development-x.com

This is the URL Link behind the "View Invoice" button is shown below:
https://ostendocloud.com:2001/api?

cmd=downloadfile&type=public&id=ADB430D4744744E9B1B24F109571C358&filename=1F0671B92
3224E3DB95431A034F14D66.pdf
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https://ostendocloud.com:2001/api?cmd=downloadfile&type=public&id=ADB430D4744744E9B1B24F109571C358&filename=1F0671B923224E3DB95431A034F14D66.pdf
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